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Chapter 1: Welcome to Serena
Orchestrated Ops

Serena Orchestrated Ops contains three solutions that can be used independently or
together to create a world-class IT solution.

The individual solutions in Serena Orchestrated Ops include:

• Serena Request Center

• Serena Demand Manager

• Serena Service Manager

This guide covers all three components. Refer to the particular sections in this guide for
information on the components that you purchased. Refer to Purpose of this Guide for
details on what this guide covers.

Serena Request Center
Serena Request Center provides a one-stop interface for corporate users to discover and
request services, submit requests, and review knowledge base articles. It comes with a
rich, interactive, and intuitive Web portal. The portal contains an enterprise service
request catalog allowing service requests to be composed, organized, and published into
convenient categories for easy access.

The portal comes pre-populated with service requests such as "New Hire Request" and
"Install/Upgrade OS" that use the Service Request workflow in the SRC - Service Request
process app. The service requests use the Starter Pack Forms, which are customized
external forms for submitting requests.

Serena Demand Manager
Serena Demand Manager enables you to capture incoming demand for projects, such as
new application development, Web site requests, or infrastructure improvements.
Demand items can span multiple business processes, but you can organize them into
plans that provide an overall view into the cost, effort, and benefit of each project.

Once demand items have been added to a plan, they can be allocated to resource teams,
scored based on various business criteria, sized so that the scope of the work is
understood, and ranked in order of priority.

Serena Demand Manager includes Serena Demand Center, an intuitive, Web-based
planning portal, and the Demand Plan process app, which manages the planning life cycle
from create to close.

Serena Service Manager
Serena Service Manager is a process-driven approach to IT service management—one
that allows business and IT to work together, in perfect harmony. Unlike traditional ITSM
solutions that are difficult to use, expensive to maintain, and provide limited visibility
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across the service delivery lifecycle, Serena Service Manager draws on the power of a
process management platform at its core to provide the following benefits:

• Lower total cost of ownership (TCO)

• Complete visibility

• Improved user satisfaction and agent productivity

• Contemporary interface for IT services

Serena Service Manager comes packaged with fully functional, easy-to-use applications
including those for Incident, Problem, Change, and Configuration Management. Service
Manager also provides the IT operations team with visual dashboards and robust report
generation capabilities so they can maintain complete visibility across the end-to-end
service delivery process. This includes the ability to view actionable metrics related to
costs and resource utilization.

Purpose of This Guide
This guide describes how to upgrade Serena Orchestrated Ops.

This guide is meant for administrators who are responsible for upgrading an existing SOO
installation. It includes detailed information on upgrading the file system and the SOO
solution files. For all other information, refer to the following documents available here:

• Serena Orchestrated Ops Installation and Configuration Guide or Serena
Orchestrated Ops On-Demand Installation and Configuration Guide for detailed
information about initially installing, configuring, and deploying the solutions.

• Serena Orchestrated Ops Implementation Guide for detailed information about
administrative duties you perform in SOO.

• Serena Service Manager Concepts Guide for details on Service Manager workflows
and their features.

• Serena Orchestrated Ops readme for a list of new features in this release.

For detailed information on modifying projects, users, workflows, or orchestrations in the
process apps after you have promoted them, refer to the following guides that are
included with your Serena® Business Manager installation:

• SBM Application Administrator Guide for configuring projects, users, and groups.

• SBM Composer Guide for modifying workflows, orchestrations, and other aspects of
process app design.

• SBM Application Repository Guide for deploying and promoting snapshots and
process apps.

• SBM Installation and Configuration Guide for installing and configuring the SBM
platform.

Chapter 1: Welcome to Serena Orchestrated Ops
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Chapter 2: Preparing for the Upgrade

This chapter contains important information to help you prepare for the upgrade.

• Overview [page 7]

• Pre-Upgrade Steps [page 8]

• Important Notes for Upgrades [page 8]

• Creating a Comparison Report in SBM Composer [page 9]

Overview
The Serena Orchestrated Ops upgrade process consists of two phases: the installation
upgrade and the solutions upgrade.

• In the installation upgrade phase, you run the SOO installer and configure your
installation using SBM Configurator. This installs the newest versions of the
framework files and configures your installation to use them.

• In the solutions upgrade phase, you import the new solutions and decide if you will
preserve or overwrite the modifications you have likely made to the process apps.

Note: The solutions upgrade phase is optional, with the exception of the Serena
Demand Manager solution. (It is recommended that you upgrade the SDM
solution to take advantage of the latest features.)

If you want to preserve your current workflows and data (forgoing the latest versions of
the SRC and SSM process apps), simply run the SOO installer and configure your
installation using SBM Configurator as described in Chapter 3: Upgrading the Installation
[page 11]. This upgrades just the framework files and completes the installation upgrade
phase.

If you want to upgrade your process apps to the latest versions as well, review the
following chapter below that corresponds to your current version, and then upgrade the
solutions:

• Chapter 4: Upgrading 4.0 Process Apps [page 13]

• Chapter 5: Upgrading 3.5 Process Apps [page 21]

• Chapter 6: Upgrading 3.1 Process Apps [page 27]

• Chapter 7: Upgrading 3.0 Process Apps [page 33]

• Chapter 8: Upgrading 2.1 Process Apps [page 45]

This upgrades both the installation and the solutions.
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Pre-Upgrade Steps
Before you begin the upgrade process:

1. If you are not using at least SBM version 10.1.1.4 or later, follow the instructions in
the SBM readme to upgrade your existing SBM installation.

2. After you have successfully upgraded to SBM 10.1.1.4 or later, back up your existing
SBM database before installing SOO.

3. Review the Important Notes for Upgrades [page 8] section to ensure your database
is prepared for the upgrade and that you are prepared to run the SOO installer on
the proper servers.

4. Decide if you will upgrade your current SOO process apps in addition to upgrading
the installation.

5. If you decide to upgrade your process apps, follow the steps described in Creating a
Comparison Report in SBM Composer [page 9] to help you identify changes you
have made to the process apps that you might want to preserve.

6. Back up the installation directory structure for SBM on your SBM Application Engine
machine.

7. Download the latest version of SOO from support.serena.com.

Important Notes for Upgrades
Review the following important notes for all upgrades from previous versions of Serena
Orchestrated Ops.

• Upgrades of Serena Demand Manager to version 4.0 are not supported. The SDM -
Project Proposal and SDM - Voting applications that were included with version 3.5
have been replaced by the SDM - Demand Plan app in SOO 4.0. To use the new
process app, import the Serena Demand Manager 4.0 solution, and then promote the
SDM - Demand Plan process app.

• After you promote the SDM - Demand Plan process app, log in to Demand Center as
an administrator using the following URL: http://serverName/tmtrack/
tmtrack.dll?shell=sdc. This populates the catalog in Demand Center.

• For Oracle systems, the Oracle schema user requires a certain set of roles and
privileges to enable "Oracle Text" for use with the Social Widget control that is
enabled by default in the SOO process apps. See S133641 for details.

Important: You must apply these roles and privileges to the Oracle
schema user prior to promoting or deploying the SOO apps.

• For SQL Servers systems, you must ensure that "Full-Text Indexing" is enabled in
the DBMS. Note the following:

▪ In SQL Server 2005, "Full-Text Indexing" is enabled automatically once you
successfully a deploy any process app in which the Social Widget is enabled, as
long as the "Full-Text Search" feature was selected during the SQL Server DBMS
install.

Chapter 2: Preparing for the Upgrade
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▪ In SQL Server 2008, "Full-Text Indexing" is selected by default for all databases,
as long as the "Full-Text Search" feature was selected during the SQL Server
DBMS install.

Note: The Full-Text Search feature in SQL Server is an optional install
component. Therefore, verify that the feature is installed in SQL Server
first. To verify this, right-click on the database in SQL Server, select
Properties, and then select the Files page. “Use full-text indexing” should
be selected.

• Prior to Serena Service Manager 3.0, the SSM installation was performed on the
server or servers that hosted the SBM Application Engine and the Application
Administrator. As of SBM 10.1, the Application Administrator was renamed to
Application Repository. The SOO installation is performed on the server or servers
that host the following SBM SBM components:

▪ SBM Application Engine

▪ SBM Application Repository

▪ SBM Common Services

Note: As of version 3.0, the Service Level Agreement (SLA) component is
included with the installation. The SLA component is installed on the SBM
server that hosts SBM Common Services. For distributed environments,
this means you must determine which SBM server hosts the SBM Common
Services component and run the SOO installer on this server to install the
SLA component.

• The SOO installation requires that you run SBM Configurator, set the appropriate SLA
load-level setting for your environment, and then click Apply after the installer is
finished. This enables SBM Configurator to perform important updates to various
configuration files on your server (or servers if your installation is distributed).

• If you do not see any services in the catalog after upgrading, perform the following
steps:

1. Copy the Common.zip and SRP.zip from
Serena\Solutions\SSM\Framework\Shell.

2. Paste both .zip files into Serena\SBM\Application Engine\payload.

3. Reset IIS.

4. Launch the User Workspace and then access Serena Request Center.

Creating a Comparison Report in SBM Composer
This section describes how to create a report in SBM Composer that helps you identify the
changes you have made to your process apps. You will use this report to determine which
changes you want to preserve and copy to the new version of each process app.

Serena recommends that you compare your current process apps to the original versions
that were packaged as part of the installation. If you did not make any changes to the
process apps or you do not want to preserve your changes, simply follow the steps in
Chapter 3: Upgrading the Installation [page 11] to upgrade the framework files to the
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latest version. If you want to use the latest versions of the process apps as well, perform
the steps described in Chapter 3: Upgrading the Installation [page 11] and then perform
the process app upgrade steps described later in this guide to import and promote the
new process apps.

To create a comparison report:

1. In Application Repository, click the Environments tab.

2. Click the environment name to open it.

3. Click the Deploy History tab.

4. Select the process app and click Open.

5. Select version 1 of the process app and then click Save to File.

6. Select the latest version of the process app that you have deployed and then click
Save to File.

Tip: Take note of this file name and save location. If you determine that
you want to preserve the modifications you have made, you will use this
file in the merge steps later on.

7. Launch SBM Composer and Import version 1 or the process app from the file you
just saved.

8. Select the Compare option from the Composer menu, and open the latest version of
the process app from the file that you saved earlier to launch a side-by-side
comparison.

9. Click the Export button to create a report that shows you the changes you have
made since the initial promotion.

10. Repeat these steps for each of your current process apps.

For details on using the Compare feature, see the "Comparing and Merging Process Apps"
topic in the SBM Composer Guide.

Chapter 2: Preparing for the Upgrade
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Chapter 3: Upgrading the Installation

This section discusses how to upgrade the installation and framework files for all SOO
upgrades.

• About the Installation Upgrade [page 11]

• Upgrading the Installation [page 11]

About the Installation Upgrade
Upgrading the installation involves running the SOO installer and configuring the
installation using SBM Configurator. You must upgrade the installation before you can
import the newest versions of the SOO solutions.

Tip: You can upgrade the installation independently from the solutions upgrade.
This means that you do not need to upgrade the solutions to take advantage of
improvements and additions that have been added to the SOO framework files.
However, it is recommended that you upgrade the SDM solution to take
advantage of improvements in that solution.

The installation upgrade process updates the SOO framework files, applies the new
configuration, and prepares the system for use by enabling SBM Application Engine to
import the upgraded framework files into the Serena Request Center user interface.

Upgrading the Installation
This section describes the steps you will follow to upgrade your current installation.

To upgrade the installation:

1. Run the SOO installer on the server or servers that host the following SBM
components:

• SBM Application Engine

• SBM Application Repository

• SBM Common Services

Note: If these SBM components are installed separately, you must run the
SOO installer on each server.

The "Welcome to the Install Wizard for Serena Orchestrated Ops" message appears.
Click Next to continue.

2. The installer detects which SBM components are currently installed on the server. A
message appears if any of the required SBM components are not detected on the
server. Click Install to install SOO.

3. Allow the installation to complete. Once the installation is finished, click Configure
to launch SBM Configurator (close and reopen SBM Configurator if it was open
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during the SOO install). In the SBM Configurator, set the SLA level for your
environment on the Orchestrated Ops tab, configure the Smart Search tab, and
then click Apply.

Important: You must launch SBM Configurator and click Apply to finish
the installation and configuration process. When you click Apply, SBM
Configurator updates various configuration files on the server and prepares
the system for use.

4. Access the SBM User Workspace using the following URL and allow the interface to
load:

http://serverName/tmtrack/tmtrack.dll?

Important: Accessing the SBM User Workspace immediately after SBM
Configurator is an important part of the upgrade process. This enables the
SBM Application Engine to import the framework files that comprise the
new simplified user interface (Serena Request Center).

This completes the installation and configuration upgrade. To upgrade the process
apps, continue to the next section that applies to your current version.

Chapter 3: Upgrading the Installation
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Chapter 4: Upgrading 4.0 Process Apps

This section discusses how to upgrade version 4.0 process apps.

• About Upgrading [page 13]

• Upgrading the Process Apps [page 14]

• Preserving Changes in the Process Apps [page 18]

About Upgrading
This section contains important information about upgrading your process apps from
version 4.0. Use this section to help you evaluate the changes that have been made to
the process apps and whether or not you want to upgrade to take advantage of the
improvements.

Process App Changes
Review the readme file below for a list of changes and new features that were introduced
since version 4.0 to help you determine if you want to upgrade your process apps.

• Click here for a list of features that were added in version 4.0.1.

Importing the Solutions
To begin upgrading your process apps, you must import the new solution files that are
delivered by the installer. Importing a solution adds all of the snapshots and process apps
for the solution to your SBM Server. The process apps and snapshots are available for
promotion or deployment after the import.

Deploying or Promoting the Process Apps
After you import the solutions, you either deploy or promote the associated snapshots into
your environment, depending on whether or not you want to preserve changes you might
have made to your process apps.

If you are upgrading from an earlier version, it is likely that you modified the process
apps; therefore, the solutions that are delivered by the installer are not automatically
deployed to your default environment. As part of the upgrade process, you must decide if
you want to preserve your modifications or if you want to overwrite the current versions
of your process apps.

Therefore, for each process app you want to upgrade, choose one of the following two
options:

• Compare, merge, and deploy – Review the comparison report you generated as
part of the pre-upgrade process. If there are modifications that you made to the
process apps that you want to preserve, use SBM Composer to compare and merge
your changes and then deploy the process apps.
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• Promote – Promote the new versions without comparing and merging, which will
overwrite your modifications (if any). Promoting the snapshots places the latest
contents of the solution, including all reports, notifications, process apps, and
auxiliary table data, onto your SBM Server.

The following section describes these options as part of the upgrade process in more
detail.

Upgrading the Process Apps
This section describes how to upgrade your 4.0 process apps to version 4.0.1.

If you began using SOO starting with version 3.1 or 3.5, proceed to Upgrading All Process
Apps [page 22]. If you upgraded to 3.1 before you upgraded to 3.5, choose one of the
following options:

• If you upgraded to version 3.1 and you promoted all the process apps at that time
(including the 3.1 version of SSM - Incident Management), follow the steps in
Upgrading All Process Apps [page 22] to upgrade your 4.0 process apps to 4.0.1.

• If you upgraded to version 3.1, but you did not promote the 3.1 version of SSM -
Incident Management (preserving either the 2.1 Incident Management or 3.0 Service
Desk apps), and you want to continue to use these older versions, follow the steps in
Upgrading All Process Apps Except Incident Management or Service Desk [page 24]
to upgrade your 4.0 process apps to 4.0.1.

Upgrading All Process Apps
To upgrade all of your existing 4.0 process apps:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Select the Solutions tab.

4. Import the SOO 4.0.1 solutions. Click the Import button to begin importing a
solution.

5. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 18] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

Chapter 4: Upgrading 4.0 Process Apps
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• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

6. Upgrade the Serena Service Manager apps.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 18] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Incident Management

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.
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7. Upgrade the Serena Demand Manager app.

If you want to preserve any custom modifications that you made to the SDM process
app, follow the steps in Preserving Changes in the Process Apps [page 18] to
compare and merge the changes and then deploy the process app instead of
promoting it now.

Otherwise, promote the following process app:

• SDM - Demand Plan

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

8. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

Upgrading All Process Apps Except Incident
Management or Service Desk
To upgrade your existing 4.0 process apps, but continue to use either the 2.1
version of Incident Management or the 3.0 version of Service Desk:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Select the Solutions tab.

4. Import the SOO 4.0.1 solutions. Click the Import button to begin importing a
solution.

5. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 18] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

Chapter 4: Upgrading 4.0 Process Apps
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• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

6. Upgrade the Serena Service Manager apps, except for the SSM - Incident
Management process app.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 18] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps. (Note that the list excludes the SSM
- Incident Management process app):

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.
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7. Upgrade the Serena Demand Manager app.

If you want to preserve any custom modifications that you made to the SDM process
app, follow the steps in Preserving Changes in the Process Apps [page 18] to
compare and merge the changes and then deploy the process app instead of
promoting it now.

Otherwise, promote the following process app:

• SDM - Demand Plan

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

8. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

Preserving Changes in the Process Apps
This section describes steps you will follow to preserve any changes you made to your
current process apps.

If you want to preserve changes that you made to your existing apps, use the Compare
feature in SBM Composer to copy your modifications into the 4.0.1 apps and preserve
them.

To merge your existing apps with the newer versions and preserve
modifications:

1. Launch SBM Composer, and then open the newest version of the process app from
the repository (which should appear after you have finished importing the new
solutions).

Tip: Make sure not to open the local cache copy of the process app. If you
are asked to overwrite or use a local copy, choose to overwrite.

2. Click the Composer button and then Compare. Select the option to compare With
Local File.

3. Select the current version of the file that you saved earlier to create the comparison
report. This version should contain all of the changes you have made to date.
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4. Use the comparison report that you generated earlier to identify the elements that
you want to preserve on the right side. Right-click the element to preserve, and then
select Copy to Open Process App to copy the change into the new version of the
app.

Note: The Compare tool in SBM Composer does not allow you to preserve
individual elements of a custom form. If you want to use the new forms
and preserve any customizations you might have made, you must merge
the entire form and then manually implement your customizations again.

5. Save the changes to the new process app, and then deploy this version. You should
now have a modified 4.0.1 version of the process app in your repository.

6. Repeat these steps for each process app that has changes you want to preserve.
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Chapter 5: Upgrading 3.5 Process Apps

This section discusses how to upgrade version 3.5 process apps.

• About Upgrading [page 21]

• Upgrading the Process Apps [page 22]

• Preserving Changes in the Process Apps [page 25]

About Upgrading
This section contains important information about upgrading your process apps from
version 3.5. Use this section to help you evaluate the changes that have been made to
the process apps and whether or not you want to upgrade to take advantage of the
improvements.

Process App Changes
Review the readme file below for a list of changes and new features that were introduced
since version 3.5 to help you determine if you want to upgrade your process apps.

• Click here for a list of features that were added in version 4.0.

• Click here for a list of features that were added in version 4.0.1.

Importing the Solutions
To begin upgrading your process apps, you must import the new solution files that are
delivered by the installer. Importing a solution adds all of the snapshots and process apps
for the solution to your SBM Server. The process apps and snapshots are available for
promotion or deployment after the import.

Deploying or Promoting the Process Apps
After you import the solutions, you either deploy or promote the associated snapshots into
your environment, depending on whether or not you want to preserve changes you might
have made to your process apps.

If you are upgrading from an earlier version, it is likely that you modified the process
apps; therefore, the solutions that are delivered by the installer are not automatically
deployed to your default environment. As part of the upgrade process, you must decide if
you want to preserve your modifications or if you want to overwrite the current versions
of your process apps.

Therefore, for each process app you want to upgrade, choose one of the following two
options:

• Compare, merge, and deploy – Review the comparison report you generated as
part of the pre-upgrade process. If there are modifications that you made to the
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process apps that you want to preserve, use SBM Composer to compare and merge
your changes and then deploy the process apps.

• Promote – Promote the new versions without comparing and merging, which will
overwrite your modifications (if any). Promoting the snapshots places the latest
contents of the solution, including all reports, notifications, process apps, and
auxiliary table data, onto your SBM Server.

The following section describes these options as part of the upgrade process in more
detail.

Upgrading the Process Apps
This section describes how to upgrade your 3.5 process apps to version 4.0.1.

If you began using SOO starting with version 3.1 or 3.5, proceed to Upgrading All Process
Apps [page 22]. If you upgraded to 3.1 before you upgraded to 3.5, choose one of the
following options:

• If you upgraded to version 3.1 and you promoted all the process apps at that time
(including the 3.1 version of SSM - Incident Management), follow the steps in
Upgrading All Process Apps [page 22] to upgrade your 3.5 process apps to 4.0.1.

• If you upgraded to version 3.1, but you did not promote the 3.1 version of SSM -
Incident Management (preserving either the 2.1 Incident Management or 3.0 Service
Desk apps), and you want to continue to use these older versions, follow the steps in
Upgrading All Process Apps Except Incident Management or Service Desk [page 24]
to upgrade your 3.5 process apps to 4.0.1.

Upgrading All Process Apps
To upgrade all of your existing 3.5 process apps:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Select the Solutions tab.

4. Import the SOO 4.0.1 solutions. Click the Import button to begin importing a
solution.

5. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 25] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

• SRC - Service Request
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• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

6. Upgrade the Serena Service Manager apps.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 25] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Incident Management

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

7. Import the Serena Demand Manager solution and promote the following process
app:

• SDM - Demand Plan
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You must select All in each drop-down list in the promotion entities dialog box.

8. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

Upgrading All Process Apps Except Incident
Management or Service Desk
To upgrade your existing 3.5 process apps, but continue to use either the 2.1
version of Incident Management or the 3.0 version of Service Desk:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Select the Solutions tab.

4. Import the SOO 4.0.1 solutions. Click the Import button to begin importing a
solution.

5. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 25] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management
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You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

6. Upgrade the Serena Service Manager apps, except for the SSM - Incident
Management process app.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 25] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps. (Note that the list excludes the SSM
- Incident Management process app):

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

7. Import the new SDM solution and promote the following process app:

• SDM - Demand Plan

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution. Select the Merge Conflicts check box during each
promotion as well.

8. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

Preserving Changes in the Process Apps
This section describes steps you will follow to preserve any changes you made to your
current process apps.
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If you want to preserve changes that you made to your existing apps, use the Compare
feature in SBM Composer to copy your modifications into the 4.0.1 apps and preserve
them.

To merge your existing apps with the newer versions and preserve
modifications:

1. Launch SBM Composer, and then open the newest version of the process app from
the repository (which should appear after you have finished importing the new
solutions).

Tip: Make sure not to open the local cache copy of the process app. If you
are asked to overwrite or use a local copy, choose to overwrite.

2. Click the Composer button and then Compare. Select the option to compare With
Local File.

3. Select the current version of the file that you saved earlier to create the comparison
report. This version should contain all of the changes you have made to date.

4. Use the comparison report that you generated earlier to identify the elements that
you want to preserve on the right side. Right-click the element to preserve, and then
select Copy to Open Process App to copy the change into the new version of the
app.

Note: The Compare tool in SBM Composer does not allow you to preserve
individual elements of a custom form. If you want to use the new forms
and preserve any customizations you might have made, you must merge
the entire form and then manually implement your customizations again.

5. Save the changes to the new process app, and then deploy this version. You should
now have a modified 4.0.1 version of the process app in your repository.

6. Repeat these steps for each process app that has changes you want to preserve.
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Chapter 6: Upgrading 3.1 Process Apps

This section discusses how to upgrade version 3.1 process apps.

• About Upgrading [page 27]

• Upgrading the Process Apps [page 28]

• Preserving Changes in the Process Apps [page 31]

About Upgrading
This section contains important information about upgrading your process apps from
version 3.1. Use this section to help you evaluate the changes that have been made to
the process apps and whether or not you want to upgrade to take advantage of the
improvements.

Process App Changes
Review the readme file below for a list of changes and new features that were introduced
since version 3.1 to help you determine if you want to upgrade your process apps.

• Click here for a list of features that were added in version 3.5.

• Click here for a list of features that were added in version 4.0.

• Click here for a list of features that were added in version 4.0.1.

Importing the Solutions
To begin upgrading your process apps, you must import the new solution files that are
delivered by the installer. Importing a solution adds all of the snapshots and process apps
for the solution to your SBM Server. The process apps and snapshots are available for
promotion or deployment after the import.

Deploying or Promoting the Process Apps
After you import the solutions, you either deploy or promote the associated snapshots into
your environment, depending on whether or not you want to preserve changes you might
have made to your process apps.

If you are upgrading from an earlier version, it is likely that you modified the process
apps; therefore, the solutions that are delivered by the installer are not automatically
deployed to your default environment. As part of the upgrade process, you must decide if
you want to preserve your modifications or if you want to overwrite the current versions
of your process apps.

Therefore, for each process app you want to upgrade, choose one of the following two
options:
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• Compare, merge, and deploy – Review the comparison report you generated as
part of the pre-upgrade process. If there are modifications that you made to the
process apps that you want to preserve, use SBM Composer to compare and merge
your changes and then deploy the process apps.

• Promote – Promote the new versions without comparing and merging, which will
overwrite your modifications (if any). Promoting the snapshots places the latest
contents of the solution, including all reports, notifications, process apps, and
auxiliary table data, onto your SBM Server.

The following section describes these options as part of the upgrade process in more
detail.

Upgrading the Process Apps
This section describes how to upgrade your 3.1 process apps to 4.0.1.

If this is your first SOO upgrade, proceed to Upgrading All Process Apps [page 28]. If you
upgraded to 3.1 prior to this upgrade, choose one of the following options:

• If you upgraded to version 3.1 and you promoted all the process apps at that time
(including the 3.1 version of SSM - Incident Management), follow the steps in
Upgrading All Process Apps [page 28] to upgrade your 3.1 process apps to 4.0.1.

• If you upgraded to version 3.1, but you did not promote the 3.1 version of SSM -
Incident Management (preserving either the 2.1 Incident Management or 3.0 Service
Desk apps), and you want to continue to use these older versions, follow the steps in
Upgrading All Process Apps Except Incident Management or Service Desk [page 30]
to upgrade your 3.1 process apps to 4.0.1.

Upgrading All Process Apps
To upgrade all of your existing 3.1 process apps:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Select the Solutions tab.

4. Import the SOO 4.0.1 solutions. Click the Import button to begin importing a
solution.

5. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 31] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

Chapter 6: Upgrading 3.1 Process Apps

28 Serena® Orchestrated Ops



• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

6. Upgrade the Serena Service Manager apps.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 31] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Incident Management

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

7. Import the new SDM solution and promote the following process app:
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• SDM - Demand Plan

You must select All in each drop-down list in the promotion entities dialog box.

8. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

Upgrading All Process Apps Except Incident
Management or Service Desk
To upgrade your existing 3.1 process apps, but continue to use either the 2.1
version of Incident Management or the 3.0 version of Service Desk:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Select the Solutions tab.

4. Import the SOO 4.0.1 solutions. Click the Import button to begin importing a
solution.

5. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 31] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

Chapter 6: Upgrading 3.1 Process Apps

30 Serena® Orchestrated Ops



You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

6. Upgrade the Serena Service Manager apps, except for the SSM - Incident
Management process app.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 31] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps. (Note that the list excludes the SSM
- Incident Management process app):

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

7. Import the new SDM solution and promote the following process app:

• SDM - Demand Plan

You must select All in each drop-down list in the promotion entities dialog box.

8. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

Preserving Changes in the Process Apps
This section describes steps you will follow to preserve any changes you made to your
current process apps.

If you want to preserve changes that you made to your existing apps, use the Compare
feature in SBM Composer to copy your modifications into the 4.0.1 apps and preserve
them.
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To merge your existing apps with the newer versions and preserve
modifications:

1. Launch SBM Composer, and then open the newest version of the process app from
the repository (which should appear after you have finished importing the new
solutions).

Tip: Make sure not to open the local cache copy of the process app. If you
are asked to overwrite or use a local copy, choose to overwrite.

2. Click the Composer button and then Compare. Select the option to compare With
Local File.

3. Select the current version of the file that you saved earlier to create the comparison
report. This version should contain all of the changes you have made to date.

4. Use the comparison report that you generated earlier to identify the elements that
you want to preserve on the right side. Right-click the element to preserve, and then
select Copy to Open Process App to copy the change into the new version of the
app.

Note: The Compare tool in SBM Composer does not allow you to preserve
individual elements of a custom form. If you want to use the new forms
and preserve any customizations you might have made, you must merge
the entire form and then manually implement your customizations again.

5. Save the changes to the new process app, and then deploy this version. You should
now have a modified 4.0.1 version of the process app in your repository.

6. Repeat these steps for each process app that has changes you want to preserve.
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Chapter 7: Upgrading 3.0 Process Apps

This section discusses how to upgrade version 3.0 process apps.

• About Upgrading [page 33]

• Upgrading the Process Apps [page 34]

• Preserving Changes in the Process Apps [page 43]

About Upgrading
This section contains important information about upgrading your process apps from
version 3.0. Use this section to help you evaluate the changes that have been made to
the process apps and whether or not you want to upgrade to take advantage of the
improvements.

Process App Changes
Review the readme files below for a list of changes and new features that were introduced
since version 3.0 to help you determine if you want to upgrade your process apps.

• Click here for a list of features that were added in version 3.1.

• Click here for a list of features that were added in version 3.5.

• Click here for a list of features that were added in version 4.0.

• Click here for a list of features that were added in version 4.0.1.

Importing the Solutions
To begin upgrading your process apps, you must import the new solution files that are
delivered by the installer. Importing a solution adds all of the snapshots and process apps
for the solution to your SBM Server. The process apps and snapshots are available for
promotion or deployment after the import.

Note: A failure message that states "You do not have permission to delete the
obselete snapshot" appears in Application Repository if your environment
contains a process app that is no longer associated with the solution you are
importing and you do not have privileges to delete the process app. In the
Deployment menu, click Privileges, and then grant the user Delete Process
App and Delete Application/Orchestration privileges to proceed with the
import.

Deploying or Promoting the Process Apps
After you import the solutions, you either deploy or promote the associated snapshots into
your environment, depending on whether or not you want to preserve changes you might
have made to your process apps.
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If you are upgrading from an earlier version, it is likely that you modified the process
apps; therefore, the solutions that are delivered by the installer are not automatically
deployed to your default environment. As part of the upgrade process, you must decide if
you want to preserve your modifications or if you want to overwrite the current versions
of your process apps.

Therefore, for each process app you want to upgrade, choose one of the following two
options:

• Compare, merge, and deploy – Review the comparison report you generated as
part of the pre-upgrade process. If there are modifications that you made to the
process apps that you want to preserve, use SBM Composer to compare and merge
your changes and then deploy the process apps.

• Promote – Promote the new versions without comparing and merging, which will
overwrite your modifications (if any). Promoting the snapshots places the latest
contents of the solution, including all reports, notifications, process apps, and
auxiliary table data, onto your SBM Server.

The following section describes these options as part of the upgrade process in more
detail.

Upgrading the Process Apps
This section describes three different scenarios for upgrading the 3.0 process apps.

In SOO 3.1, the Service Request workflow was removed from the Service Desk process
app that was included with SSM and SRC in version 3.0. In its place, a new Service
Request process app was created as part of the SRC solution. The Service Desk process
app that was formerly part of the SRC solution was renamed to "Incident Management" in
3.1 (though it has the same UUID). Given these changes, there are special upgrade
considerations for the Service Desk process app.

Depending on how you used the Service Request and Incident workflows in version 3.0,
there are three upgrade options for the Service Desk process app:

• Upgrade and delete all existing Service Desk data. For details, see Upgrading 3.0
Process Apps and Deleting Existing Service Desk Data [page 34].

• Upgrade and preserve your existing Service Desk data. For details, see Upgrading
3.0 Process Apps and Preserving Existing Service Desk Data [page 36].

• Leave the current version of the Service Desk intact and continue using your existing
Service Request, Incident, and Task workflows. For details, see Upgrading 3.0
Process Apps Without Upgrading Service Desk [page 42].

Upgrading 3.0 Process Apps and Deleting Existing
Service Desk Data
To upgrade your existing 3.0 process apps and delete your current Service Desk
data:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:
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http://serverName:port/mashupmgr

3. Grant your user account the following privileges: Delete Process App and Delete
Application/Orchestration.

4. Open the Environments view, click Deployed Process Apps, select the 3.0
version of the SSM – Service Desk process app, and click Undeploy Process App.

Important: This operation permanently deletes the SSM - Service Desk
3.0 primary tables, auxiliary tables, workflows, and projects.

5. Select the Solutions tab.

6. Import the SOO 4.0.1 solutions. Click the Import button to begin importing a
solution.

7. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 43] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

8. Upgrade the Serena Service Manager apps.
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If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 43] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Incident Management

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

9. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

10. Edit each service request that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Request Catalog, a red exclamation mark will appear next
to each service request that needs to be updated). For example, edit Printer Service
Request, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The service requests and projects must have a one-to-one
relationship. This means each service request must have a dedicated
project; the same project cannot be selected in multiple service requests.

Upgrading 3.0 Process Apps and Preserving Existing
Service Desk Data
To upgrade your existing 3.0 process apps and preserve your current Service
Desk data:

1. Create a backup of your SBM database. Consult your DBA and restore this backup
into a new database space or schema.

2. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

3. Log in to SBM Application Repository using the following URL:
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http://serverName:port/mashupmgr

4. Grant your user account the following privileges: Delete Process App and Delete
Application/Orchestration.

5. Open the Environments view, click Deployed Process Apps, select the 3.0
version of the SSM – Service Desk process app, and click Undeploy Process App.

Important: This operation permanently deletes the Service Desk primary
tables, auxiliary tables, workflows, and projects. The following steps will
help you restore these elements and their associated data.

6. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 43] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

7. Upgrade the Serena Service Manager apps.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 43] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.
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Otherwise, promote the following process apps:

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Incident Management

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

8. Open SBM System Administrator.

9. Import the Incident data from the backed up database you restored in step 1 by
performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select the Incidents
project under Service Desk. Click Next.

g. In the Destination Table drop-down list, select Incidents.

h. In the Destination Project drop-down list, select Incidents <- Incident
Management <- Base Project. Click Next.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Incidents). Click Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created (like Incidents). Click Next.
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n. Click Finish to execute the import.

o. Repeat these steps for any additional projects that you might have created under
the Incidents project.

p. Verify that your 3.0 data is now available in the SBM User Workspace.

10. Import the Service Requests data from the backed up database you restored in step
1 by performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select a Service
Request sub-project. For example, select Printer Service Request if users
submitted items into that project in SSM 3.0.

Tip: The following table lists the Service Request projects in 3.0 that
now have different names. The updated name appears in the SRC -
Service Request Project Name column.

SSM - Service Desk 3.0
Project Name

SRC - Service Request
Project Name

Client Software Install Request Client Software Install

Facilities Suggestions Suggestion Box

Network Printer Access Request Network Printer Access

New Access Badge Request New Access Badge

New PC Request New Desktop Install

New Server Install Request Install Server

Office Move Request Office Move

Request to Upgrade OS Install OS

Note that this list only contains the project names that originally
shipped with SSM and SRC that have changed. If you changed these
project names, changed any other project names (which would
otherwise match), or created new sub-projects, the list of sub-projects
that appear under Service Request might be different.
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After you have selected the source project, click Next.

g. In the Destination Table drop-down list, select Service Requests.

h. In the Destination Project drop-down list, select the new version of the Service
Request project that corresponds to the older version. To continue with the
previous example, select Printer Service Request <-IT Services for Users <-
Service Request.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

Tip: Consider setting a constant user with item ownership privileges for
the Fulfiller and Purchaser fields. These fields drive ownership in the
Fulfillment and Purchasing states.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Printer Service Requests). Click
Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created. Click Next.

n. Click Finish to execute the data import.

o. Repeat these steps for each Service Request project.

p. Perform the same data import steps (without selecting projects) for the following
auxiliary tables that have been moved to the SRC - Service Requests process
app:

• SRC - Client Software

• SRC - Computer Models

• SRC - Computer Types

• SRC - Mobile Carriers

• SRC - Mobile Device Platforms

• SRC - Mobile Devices

• SRC - Operating Systems

For example, create a new import option set for Client Software table that was
part of the 3.0 version of Service Desk. Import the data from this table into the
new version: SRC - Client Software. This ensures that any of the auxiliary data
that you added to the Service Desk versions of these tables is preserved.

q. Verify that your 3.0 data is now available in the SBM User Workspace.
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11. Import the Tasks data from the backed up database you restored in step 1 by
performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select the Tasks
project. Click Next.

g. In the Destination Table drop-down list, select Service Requests.

h. In the Destination Project drop-down list, select Service Request Tasks <-
Service Request <- Base Project in the Destination Project. Click Next.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Tasks). Click Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created (like Tasks). Click Next.

n. Click Finish to execute the import.

o. Verify that your data is now available in the SBM User Workspace.

12. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

13. Edit each service request that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Request Catalog, a red exclamation mark will appear next
to each service request that needs to be updated). For example, edit Printer Service
Request, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The service requests and projects must have a one-to-one
relationship. This means each service request must have a dedicated
project; the same project cannot be selected in multiple service requests.
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Upgrading 3.0 Process Apps Without Upgrading Service
Desk
To upgrade your existing 3.0 process apps, but continue to use your current
version of the Service Desk:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 43] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

4. Upgrade the Serena Service Manager apps, except for the SSM - Incident
Management process app.
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If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 43] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps. (Note that the list excludes the SSM
- Incident Management process app):

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

5. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

6. Edit each service request that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Request Catalog, a red exclamation mark will appear next
to each service request that needs to be updated). For example, edit Printer Service
Request, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The service requests and projects must have a one-to-one
relationship. This means each service request must have a dedicated
project; the same project cannot be selected in multiple service requests.

Preserving Changes in the Process Apps
This section describes steps you will follow to preserve any changes you made to your
current process apps.

If you want to preserve changes that you made to your existing apps, use the Compare
feature in SBM Composer to copy your modifications into the 4.0.1 apps and preserve
them.
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To merge your existing apps with the newer versions and preserve
modifications:

1. Launch SBM Composer, and then open the newest version of the process app from
the repository (which should appear after you have finished importing the new
solutions).

Tip: Make sure not to open the local cache copy of the process app. If you
are asked to overwrite or use a local copy, choose to overwrite.

2. Click the Composer button and then Compare. Select the option to compare With
Local File.

3. Select the current version of the file that you saved earlier to create the comparison
report. This version should contain all of the changes you have made to date.

4. Use the comparison report that you generated earlier to identify the elements that
you want to preserve on the right side. Right-click the element to preserve, and then
select Copy to Open Process App to copy the change into the new version of the
app.

Note: The Compare tool in SBM Composer does not allow you to preserve
individual elements of a custom form. If you want to use the new forms
and preserve any customizations you might have made, you must merge
the entire form and then manually implement your customizations again.

5. Save the changes to the new process app, and then deploy this version. You should
now have a modified 4.0.1 version of the process app in your repository.

6. Repeat these steps for each process app that has changes you want to preserve.
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Chapter 8: Upgrading 2.1 Process Apps

This section discusses how to upgrade version 2.1 process apps.

• About Upgrading [page 45]

• Upgrading the Process Apps [page 46]

• Preserving Changes in the Process Apps [page 55]

About Upgrading
This section contains important information about upgrading your process apps from
version 2.1. Use this section to help you evaluate the changes that have been made to
the process apps and whether or not you want to upgrade to take advantage of the
improvements.

Process App Changes
Review the readme files below for a list of changes and new features that were introduced
since version 2.1 to help you determine if you want to upgrade your process apps.

• Click here for a list of features that were added in version 3.0.

• Click here for a list of features that were added in version 3.1.

• Click here for a list of features that were added in version 3.5.

• Click here for a list of features that were added in version 4.0.

• Click here for a list of features that were added in version 4.0.1.

Importing the Solutions
To begin upgrading your process apps, you must import the new solution files that are
delivered by the installer. Importing a solution adds all of the snapshots and process apps
for the solution to your SBM Server. The process apps and snapshots are available for
promotion or deployment after the import.

Note: A failure message that states "You do not have permission to delete the
obselete snapshot" appears in Application Repository if your environment
contains a process app that is no longer associated with the solution you are
importing and you do not have privileges to delete the process app. In the
Deployment menu, click Privileges, and then grant the user Delete Process
App and Delete Application/Orchestration privileges to proceed with the
import.
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Deploying or Promoting the Process Apps
After you import the solutions, you either deploy or promote the associated snapshots into
your environment, depending on whether or not you want to preserve changes you might
have made to your process apps.

If you are upgrading from an earlier version, it is likely that you modified the process
apps; therefore, the solutions that are delivered by the installer are not automatically
deployed to your default environment. As part of the upgrade process, you must decide if
you want to preserve your modifications or if you want to overwrite the current versions
of your process apps.

Therefore, for each process app you want to upgrade, choose one of the following two
options:

• Compare, merge, and deploy – Review the comparison report you generated as
part of the pre-upgrade process. If there are modifications that you made to the
process apps that you want to preserve, use SBM Composer to compare and merge
your changes and then deploy the process apps.

• Promote – Promote the new versions without comparing and merging, which will
overwrite your modifications (if any). Promoting the snapshots places the latest
contents of the solution, including all reports, notifications, process apps, and
auxiliary table data, onto your SBM Server.

The following section describes these options as part of the upgrade process in more
detail.

Upgrading the Process Apps
This section describes three different scenarios for upgrading the SSM 2.1 process apps.

In SOO 3.1, the Service Request workflow was removed from the Incident Management
process app that was included with SSM 2.1. In its place, a new Service Request process
app was created as part of the SRC solution. Given these changes, there are special
upgrade considerations for the Service Desk process app.

Depending on how you have used the Incident Management workflows, choose one of the
following upgrade options:

• Upgrade and delete all existing Incident Management data. For details, see
Upgrading 2.1 Process Apps and Deleting Existing Incident Management Data [page
47].

• Upgrade and preserve your existing Incident Management data. For details, see
Upgrading 2.1 Process Apps and Preserving Existing Incident Management Data
[page 49].

• Leave the current version of the Incident Management intact and continue using your
existing Service Request, Incident, and Task workflows. For details, see Upgrading
2.1 Process Apps Without Upgrading Incident Management [page 53].
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Upgrading 2.1 Process Apps and Deleting Existing
Incident Management Data
To upgrade your existing process apps and delete your current Incident
Management data:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Grant your user account the following privileges: Delete Process App and Delete
Application/Orchestration.

4. Open the Environments view, click Deployed Process Apps, select the 2.1
Incident Management process app, and click Undeploy Process App.

Important: This operation permanently deletes the Incident Management
primary tables, auxiliary tables, workflows, and projects.

5. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 55] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management
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You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

6. Upgrade the Serena Service Manager apps.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 55] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Incident Management

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

7. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

8. Edit each service request that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Request Catalog, a red exclamation mark will appear next
to each service request that needs to be updated). For example, edit Printer Service
Request, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The service requests and projects must have a one-to-one
relationship. This means each service request must have a dedicated
project; the same project cannot be selected in multiple service requests.
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Upgrading 2.1 Process Apps and Preserving Existing
Incident Management Data
To upgrade your existing process apps and preserve your current Incident
Management data:

1. Create a backup of your SBM database. Consult your DBA and restore this backup
into a new database space or schema.

2. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

3. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

4. Grant your user account the following privileges: Delete Process App and Delete
Application/Orchestration.

5. Open the Environments view, click Deployed Process Apps, select the 2.1
Incident Management process app, and click Undeploy Process App.

Important: This operation permanently deletes the Incident Management
primary tables, auxiliary tables, workflows, and projects. The following
steps will help you restore these elements and their associated data.

6. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 55] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

Upgrade Guide 49



You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

7. Upgrade the Serena Service Manager apps.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 55] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Incident Management

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

8. Open SBM System Administrator.

9. Import the Incident data from the backed up database you restored in step 1 by
performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select the Incidents
project. Click Next.
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g. In the Destination Table drop-down list, select Incidents.

h. In the Destination Project drop-down list, select Incidents <- Incident
Management <- Base Project. Click Next.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Incidents). Click Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created (like Incidents). Click Next.

n. Click Finish to execute the import.

o. Verify that your data is now available in the SBM User Workspace.

10. Import the Service Requests data from the backed up database you restored in step
1 by performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select the Service
Requests project. Click Next.

g. In the Destination Table drop-down list, select Service Requests.

h. In the Destination Project drop-down list, select General Service Requests
<- Service Request <- Base Project.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

Tip: Consider setting a constant user with item ownership privileges for
the Fulfiller and Purchaser fields. These fields drive ownership in the
Fulfillment and Purchasing states.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Service Requests). Click Finish.

l. From the Tools menu, select Import from Database.
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m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created. Click Next.

n. Click Finish to execute the data import.

o. Perform the same data import steps (without selecting projects) for the following
auxiliary tables that have been moved to the SRC - Service Requests process
app:

• SRC - Client Software

• SRC - Computer Models

• SRC - Computer Types

• SRC - Mobile Carriers

• SRC - Mobile Device Platforms

• SRC - Mobile Devices

• SRC - Operating Systems

For example, create a new import option set for Client Software table that was
part of the 2.1 version. Import the data from this table into the new version:
SRC - Client Software. This ensures that any of the auxiliary data that you added
to the Incident Managment versions of these tables is preserved.

p. Verify that your data is now available in the SBM User Workspace.

11. Import the Tasks data from the backed up database you restored in step 1 by
performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select the Tasks
project. Click Next.

g. In the Destination Table drop-down list, select Service Requests.

h. In the Destination Project drop-down list, select Service Request Tasks <-
Service Request <- Base Project in the Destination Project. Click Next.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.
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k. Enter a name for this import option set (like Tasks). Click Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created (like Tasks). Click Next.

n. Click Finish to execute the import.

o. Verify that your data is now available in the SBM User Workspace.

12. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

13. Edit each service request that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Request Catalog, a red exclamation mark will appear next
to each service request that needs to be updated). For example, edit Printer Service
Request, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The service requests and projects must have a one-to-one
relationship. This means each service request must have a dedicated
project; the same project cannot be selected in multiple service requests.

Upgrading 2.1 Process Apps Without Upgrading
Incident Management
To upgrade your existing process apps, but continue to use your current version
of Incident Management:

1. Install and configure the latest version of SOO as described in Chapter 3: Upgrading
the Installation [page 11]. This upgrades the SOO framework files.

2. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

3. Upgrade the Serena Request Center apps.

If you want to preserve any custom modifications that you made to the SRC process
apps, follow the steps in Preserving Changes in the Process Apps [page 55] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps:
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• SRC - Starter Pack Forms - IT

• SRC - Service Request

• SRC - Knowledge Management

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Request process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Request

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

4. Upgrade the Serena Service Manager apps, except for the SSM - Incident
Management process app.

If you want to preserve any custom modifications that you made to the SSM process
apps, follow the steps in Preserving Changes in the Process Apps [page 55] to
compare and merge the changes and then deploy the process apps instead of
promoting them now.

Otherwise, promote the following process apps. (Note that the list excludes the SSM
- Incident Management process app):

• SSM - Change Management

• SSM - Configuration Management System

• SSM - Problem Management

You must select All in each drop-down list in the promotion entities dialog box to
upgrade the entire solution.

Note: Select the Merge conflicts option if you have already promoted an
earlier version of the snapshot to the target environment and you want to
preserve changes that you made to the existing application. For example,
if you want to keep new user roles that you added to an application, select
the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.
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5. Launch Serena Request Center, click Customize, and select Service Request
Catalog. Review each service request and service request category in the Request
Center to ensure accuracy and uniqueness.

6. Edit each service request that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Request Catalog, a red exclamation mark will appear next
to each service request that needs to be updated). For example, edit Printer Service
Request, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The service requests and projects must have a one-to-one
relationship. This means each service request must have a dedicated
project; the same project cannot be selected in multiple service requests.

Preserving Changes in the Process Apps
This section describes steps you will follow to preserve any changes you made to your
current process apps.

If you want to preserve changes that you made to your existing apps, use the Compare
feature in SBM Composer to copy your modifications into the 4.0.1 apps and preserve
them.

To merge your existing apps with the newer versions and preserve
modifications:

1. Launch SBM Composer, and then open the newest version of the process app from
the repository (which should appear after you have finished importing the new
solutions).

Tip: Make sure not to open the local cache copy of the process app. If you
are asked to overwrite or use a local copy, choose to overwrite.

2. Click the Composer button and then Compare. Select the option to compare With
Local File.

3. Select the current version of the file that you saved earlier to create the comparison
report. This version should contain all of the changes you have made to date.

4. Use the comparison report that you generated earlier to identify the elements that
you want to preserve on the right side. Right-click the element to preserve, and then
select Copy to Open Process App to copy the change into the new version of the
app.

Note: The Compare tool in SBM Composer does not allow you to preserve
individual elements of a custom form. If you want to use the new forms
and preserve any customizations you might have made, you must merge
the entire form and then manually implement your customizations again.

5. Save the changes to the new process app, and then deploy this version. You should
now have a modified 4.0.1 version of the process app in your repository.

6. Repeat these steps for each process app that has changes you want to preserve.
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Chapter 9: Post-Upgrade Tasks

This section describes tasks that you perform after you upgrade your installation.

Updating Service Requests in Serena Request
Center

• Each service request definition in Serena Request Center requires its own project.
This means you must review all the service requests in the entire catalog and set the
correct project or create new projects for them.

Note: The service requests and projects must have a one-to-one
relationship. This means each service request must have a dedicated
project; the same project cannot be selected in multiple service requests.

• Log in to the Request Center and set the display order for service request categories
and service requests.

• When you promote the Starter Pack Forms, new Starter Pack Services are added to
the catalog. You may want to disable these service requests by hiding them in
Serena Request Center. Refer to the Serena Orchestrated Ops Implementation Guide
for a list of these service requests.

Preparing the System for Use
• After you have promoted the SRC - Service Request snapshot, configure the

Requests view in Request Center to point at the "Requests Center - My Requests"
report contained in the snapshot. See Serena Orchestrated Ops Implementation
Guide for details on configuring Request Center.

• If you also have SSM, modify the multi-table report, "Requests Center - My
Requests," under the Service Request solution tab to include the Incident
Management table. This allows users to see incidents that they have submitted in
Request Center.

• If you also have SDM, modify the multi-table report, "Requests Center - My
Requests," under the Service Request solution tab to include the Demand Plan table.
This allows users to see project proposals that they have submitted in Request
Center. See Serena Orchestrated Ops Implementation Guide for details on
configuring the Requests view.

• Determine if you need to configure your orchestrations to be authenticated under a
specific user account as described in the "Setting Authentication for Orchestrations"
topic in the Serena Orchestrated Ops Installation and Configuration Guide.

• Add auxiliary data, set default field values, assign users to appropriate roles, and
define SLAs as described in the Serena Orchestrated Ops Implementation Guide.
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